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Programme objectives  

The course helps the student to  

1. Understand and apply the applications of chemiinformatics in drug design. 

 

Programme objectives  

The course enable the student to  

1. Apply the applications of chemiinformatics in drug design. 

 

 

Hands-on Exercises 

Application of Chemoinformatics in Drug Design 

 

Suggested Readings 

 

Text Books: 

 

1. Andrew R. Leach & Valerie, J. Gillet. (2007). An introduction to Chemoinformatics.            

Springer: The Netherlands. 

1. Gasteiger, J. & Engel, T. (2003).Chemoinformatics: A text-book. Wiley-VCH. 

 

Reference Book 

 

1. Gupta, S. P. (2011). QSAR & Molecular Modeling. New Delhi: Anamaya Pub. 
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 W: www.kj-gibbs.uio.no/kjemi/manuals/chemBioDraw10-E.pdf 

 

S.NO 
LECTURE 

DURATION 
TOPICS TO BE COVERED SUPPORT MATERIALS 

1.  3 Procedure writing W 

2.  3 Drawing Chemical structure using chemdraw W 

3.  3 
Elemental Analysis, Molecular weight & m/z 

values 
W 

4.  3 Predict the 1H-NMR using chemdraw W 

5.  3 Predict the C13-NMR using chemdraw W 

6.  3 
Determination of chemical properties, melting 

point and boiling point etc 
W 

7.  3 Convert name into structure and vice versa W 

8.  3 Find  the structure using protein bank  

9.  3 Molecular docking  

10.  3 Viva-voce  

11.  3 Model examination  

12.  3 Model examination  



Experiment.1 

Draw the chemical structure using Chemdraw 

Aim 

To learn how to draw the chemical structure of the organic compounds using Chemdraw Ultra 8.0 

software 

Tutorial on the Use of ChemDraw. 

On the laptop, double click on the Macintosh HD icon. Double click on the Applications folder and 

look for the CS ChemOffice 2004 folder.  Double click on the CS ChemDraw Pro icon. 

(Alternatively, if the ChemDraw icon is present in the dock, you may simply select that.) 

To insert structures or reactions into another document such as Word, select the structuresor reactions 

as described below, then copy and paste into the document. 

On the left is a tool palette. This is where you choose various tools for drawing structures. 

Select the single bond tool (straight line) and click in the main window. A bond will be drawn. This is 

actually a line representation of Ethane, CH3-CH3. Click on one end of the bond. A second bond 

forms. This would be propane, CH3-CH2-CH3. Next click on the end of a bond and instead of letting 

the mouse button go, drag the mouse around. This will add another carbon but it allows you to place it 

at a different angle. Letting it add the carbon by itself produces a “normal-looking” structure. 

Select the six-membered ring (cyclohexane) and click in the main window. A cyclohexane line 

drawing is produced. You can select the single bond tool and connect a CH3 to one of the carbons of 

cyclohexane to make methylcyclohexane. 

Selecting and moving objects. Select the lasso or marquee tool and click on a molecule. One click 

selects an atom or bond and double clicking selects the entire molecule. Several molecules and objects 

may be selected by surrounding the objects with one of the selection tools. The selection may be 

moved around by dragging it with the mouse. 

To make a double bond, you can select the bond you would like to convert to a double bond, and by 

clicking on it with the single bond tool, it will change it into a double bond. If you would like to hange 

it back to a single bond, you may use the eraser tool to do so. Just select the eraser tool and click on 

the atom or bond that you wish to erase. 

To add a functional group, for example, OH, select the text tool and click on the atom that you want to 

change to that group. Type in OH and an alcohol will be drawn. 

Result: 

We learned the draw the chemical structure of the Ethane, Propane, Cyclohexane, Methyl 

cyclohexane Butane, Benzene, Naphthalene, Anthracene and methane structures.  

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Experiment: 2 

ELEMENTAL ANALYSIS, MOLECULAR WEIGHT, AND m/z VALUES 

Aim 

To learn how to analysis the chemical structure of the organic compounds using Chemdraw 

Ultra 8.0 software 

The Analysis window displays the chemical formula, exact mass, molecular weight, m/z, and 

elemental analysis for the entire document, a structure, part of a structure, or a caption in 

Formula style. To view analysis information, click the ShowAnalysis Window command on 

the View menu. The Analysis window appears. 

 
Figure : Analysis window 

 

Values for selected objects in the document window are shown. If no structure is selected in 

your document, values for the entire document are shown. You can have this window open as 

you draw in the document. It shows the current values as you draw. The Decimals setting 

applies to Exact Mass,  

Molecular Weight, and m/z only. 

Property Description 
Formula: The molecular formula showing the exact number of atoms of each element in the 

molecule and charges, radicals, and isotopes. 

Exact Mass: The exact molecular mass of the structure, where atomic masses of each atom 

are based on the most common isotope for the element. 

Molecular Weight: The average molecular mass of the structure, where atomic masses are 

based on the natural abundance of all isotopes of the element. 

Property Description 
m/z Mass/charge, where charge =1. The weights of the most common isotopes and a 

graphical representation of the isotopic abundance is shown. The molecular weight shown 

takes the isotopes for each atom and their natural abundance into account. Where there is 

more than one abundant isotope, 

ChemDraw computes multiple molecular weights.Low abundance combinations (whether 

because the isotope is in low abundance or because it includes 

Many moderate-abundance contributions) are not taken into account. You cannot paste the 

graph in adocument. 

 



Elemental Analysis: The percent by weight of each element in the structure. 

 

To paste information about a structure as a caption: 

1. Click the check boxes for the information that you want to paste. 

2. Click Paste. 

The information appears as a multiline caption below the structure. You can edit this 

information with the text tool. 

 

Result: 

We learned the elemental analysis, molecular weight, and m/z values of the organic 

compounds using Chemdraw Ultra 8.0 software 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Experiment: 3 

PREDICT THE 1H - NMR STRUCTURE OF CHEMICAL COMPOUND USING 

CHEMDRAW 
 

Aim 

To learn how to predict the 1H - NMR structure of the organic compounds using Chemdraw 

Ultra 8.0 software 

ChemNMR (Ultra Feature) 

Using ChemNMR, you can estimate and display proton and Carbon-13 chemical shifts for a 

selected molecule.As with ChemBioDraw, you can also use ChemBio3D to predict NMR. 

ChemBio3D includes several interfaces tocomputational chemistry packages which predict 

NMR. Some packages predict IR spectra and other spectra as well.For more information on 

ChemBio3D packages, which have NMR predictions, and their available parameters, see the 

Chem& Bio 3D User Guide. 

Setting Parameters Values in ChemNMR 

Use the ChemNMR option in Preferences dialog to set the parameter values in ChemNMR. 

See the example below: 

Solvent 

The solvent is not user-definable in ChemNMR, except by adding new custom shift 

correction data. Most spectra in 

the default ChemNMR database are run in deuterated chloroform, but the database is 

intended to be solvent-free. In 

ChemBioDraw, you can set either deuterated chloroform, or deuterated dimethyl sulfoxide as 

solvent from the Preferences 

dialog. Spectral shifts which depend on the solvent are generally indicated as "rough" 

predictions. 

Spectrometer Frequency 

ChemNMR' s default for estimating proton NMR is a spectrometer frequency of 300 MHz. 

To change the default frequency, 

either set the new frequency using the Preferences dialog, or hold the <Alt> key while 

selecting Predict 1HNMR 

Shifts, and enter a frequency in MHz and run the spectrum. The new frequency will apply 

until you reset it, 

including after closing ChemBioDraw. The spectrometer frequency parameter only applies to 

proton NMR. 

 

Result: 

We learned the predict the 1H - NMR structure of the organic compounds using Chemdraw 

Ultra 8.0 software 
 

 

 

 

 

 

 



Experiment: 4 

PREDICT THE C13 – NMR STRUCTRUE USING CHEMDRAW 

Aim 

To learn how to predict the C13 – NMRstructure of the organic compounds using Chemdraw Ultra 8.0 

software 

NMR Shifts 

ChemNMR estimates chemical shifts for all hydrogen or carbon atoms for which additivity rules are available. 

Followinga hierarchical list, it first identifies key substructures of a molecule. A substructure provides the base 

value forthe estimated shift. For example, benzene would be the key substructure of trinitrotoluene.When a 

substructure is a ring system not available in the data, ChemNMR approximates its base shift using 

embeddedrings and, if necessary, will disassemble the ring into acyclic substructures. 

ChemNMR views remaining parts of the molecule as substituents of a substructure. Each substituent adds to, or 

subtractsfrom, the base shift of the substructure to which it is attached. Additivity rules determine the increment 

of eachcontribution. If an increment for a substituent cannot be determined, ChemNMR uses embedded 

substituents—smallerstructural units with the same neighboring atoms. Or, it will use increments of identical, or 

embedded substituents,of a corresponding substructure by assuming that the effects of the substituents are of the 

same magnitude. 

ChemNMR provides a detailed protocol of the estimation process applied. It gives substructures as names, 

compoundclasses in most cases, substituents in the form of a linear code, respectively. 

It also implements models for ethylenes (cis/trans) and cyclohexanes (equatorial/axial) 

To view1H or13C NMR information: 

1. Select a structure. 

2. Navigate to Structure>Predict 1H-NMR Shifts or Predict 13C-NMR Shifts. 

ChemNMR redraws the molecule with the estimated shifts and displays the information and line spectrum in a 

newwindow. 

Modifying NMR Frequency 

You can change the default NMR frequency of 300 Mhz in ChemDraw Proton NMR predictions. 

To change the frequency: 

Result: 

We learned the predict the C13 – NMRstructure of the organic compounds using Chemdraw Ultra 

8.0 software 

 

 

 

 



Experiment: 5 

 

DETERMIANATION OF CHEMICAL PROPERTIES OF THE ORGANIC 

COMPOUNDS 

Aim 

To learn how to analysis the chemical properties of the organic compounds using Chemdraw 

Ultra 8.0 software 

Viewing the Chemical PropertiesWindow 

To view predicted properties for a selected structure: 

1. Select the structure to analyze. 

2. Click 

the Show Chemical Properties Window 

command on the View menu. 

The Chemical Properties window appears. 

 

Figure  Chemical properties window 

 

 

 

 

 

 

 

 

The following basic values are displayed. 

 

Property Description 

Boiling Point: The boiling point for thestructure. Reported in Kelvin at 1 atm.  

Melting Point: The melting point for thestructure. Reported in Kelvinat 1 atm.  



Critical Temperature:The temperature above whichthe gas form of the structurecannot be 

liquefied, no matterthe applied pressure (T).Reported in Kelvin. 

Critical Pressure: The minimum pressure thatmust be applied to liquefy thestructure at the 

criticaltemperature (Pc). Reported inbars.  

Critical Volume: The volume occupied at thecompound’s critical temperatureandpressure 

(Vc). Reportedin cm3/mol. 

Gibbs Energy: The Gibbs free energy, ∆G,for the structure. Reported inkJ/mol at 1 atm and 

298.15K. 

Henry’s Law: The inverse of the logarithmof Henry’s law constant[-log (H)] (no units). 

 

Result:  

We learned the chemical properties ofthe organic compounds using Chemdraw Ultra 8.0 

software 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Experiment: 6 

DETERMINATION OF MELTING POINT AND BOILING POINT OF 

COMPOUNDS  

AIM: 

      To determine the melting point and boiling point of chemical compounds using chemdraw. 

 Chemical Properties: 

ChemDraw Pro and Ultra, using an add-on, ChemProp, calculate predicted values for the physical and 

thermodynamic properties of a selected structure of up to 100 atoms. You can view the values in the 

Chemical Properties window. The properties are calculated using the most reliable methods for 

calculation for the given structure. Log P and MR values based on literature values rather than a 

calculation are included in the report file. Viewing the Chemical Prop- erties Window 

To view predicted properties for a selected struc- ture: 1. Select the structure to analyze. 2. Click the 

Show Chemical Properties Window command on the View menu. The Chemical Properties window 

appears. Figure 6 - 9: Chemical properties window  

To paste the basic properties into your document: • Click Paste. To create a report and view results for 

other fragmentation methods including the Broto, Crippen, Viswanadhan, Joback, and Joback/Stein 

methods: • Click Report. 

Property Description 

Boiling Point The boiling point for the structure. Reported in Kelvin at 1 atm.  

Melting Point The melting point for the structure. Reported in Kelvin at 1 atm.  

Critical Temperature 

The temperature above which the gas form of the structure cannot be liquefied, no matter the applied 

pressure (Tc). Reported in Kelvin. 

Critical Pressure The minimum pressure that must be applied to liquefy the structure at the critical 

temperature (Pc). Reported in bars.  

Critical Volume The volume occupied at the compound’s critical tempera- ture and pressure (Vc). 

Reported in cm3/mol. 

Gibbs Energy The Gibbs free energy, ∆G, for the structure. Reported in kJ/mol at 1 atm and 298.15K. 

Henry’s Law The inverse of the logarithm of Henry’s law constant [-log (H)] (no units). 



Heat of Forma- tionThe heat of formation, ∆Hf, for the structure. Reported in kJ/mol at 1 atm and 

298.15K.tPSA Calculation of polar surface area based on fragment contributions.CLogP The 

calculated n-octanol/water partition coefficient (log Pow).CMR The calculated Molar Refrac- tivity 

 

 RESULT: 

We learned about the melting point and boiling point of the organic compound using chem draw. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Experiment: 7 

CONVERT STRUCTUREINTO NAMEOF THE ORGANIC COMPOUND USING 

CHEMDRAW 

AIM: 

     To learn to draw the structure into name of the organic compound using chemdraw 

Struct=Name (Ultra Feature) 

 

ChemBioDraw includes two features for generating structures and chemical names—Name>Structand 

Struct>Name. Collectively, these features are called Struct=Name. 

Struct>Name generates the names of chemical structures using the Cahn-Ingold-Prelog rules for 

stereochemistry. 

Using this option, you can generate the name of structures you have drawn. 

Name>Struct lets you convert chemical names into their corresponding chemical structures. It is designed to 

interpret 

chemical names as they are used by chemists. In other words, it recognizes the shorthand and slang of everyday 

usage, in addition to recognizing most of the official IUPAC, IUBMB, and CAS rules and recommendations. 

Struct>Name 

Struct>Name can interpret a variety of chemical structures. This means that you can draw a structure and 

Struct>Name will provide its name. It also updates the name when you modify the structure. 

Using Struct>Name 

To generate the name of your structure: 

1. Select the structure. 

2. Navigate to Structure>Convert Structure to Name. The name appears under the structure. 

Supported Structures 

However, Struct>Name will interpret: 

 

RESULT: 

We learned how to convert the structure into name of the chemical compounds using chem draw. 

 

 

 

 

 



Experiment: 8 

CONVERT THE NAME OF THE COMPOUND TO CHEMICAL STRUCTURE USING 

CHEMDRAW  

AIM 

To learn to draw the name into strucure of the organic compound using chemdraw. 

Name=Struct 

You can draw a structure automatically from a chemical name using Name=Struct. Name=Struct 

recognizes most organic nomenclature. Inorganic chemistry is also usually recognized, especially 

when the rules closely match those for organic chemistry.  

The following are not supported: 

                                   • Coordination complexes 

                                   • Polyborane 

                                   • Polymers 

 

• Some highly-bridged ring systems, including fullerenes and porphyrins/porphines 

• Some stereochemistry designators: +, -, +/-, +-, D, L, DL, endo, exo, syn, anti, r, t, c 

Although some trade names are supported, Name=Struct is not intended to interpret trade or common 

names. A chemical database, such as chemfinder.com, is more appropriate for obtaining structures for 

trade or common names. See “Finding Information on ChemFinder.com” on page 258 for more 

information. 

NOTE: Because the syntax of German is very similar to that of English, Name=Struct can also 

interpret many German names. Chemical names in other languages, however, will generally not be 

recognized. 

 Converting Names to Struc- tures 

There are two ways to insert a name into the document window as a structure: 

• Insert Structure dialog box  

• Paste Special command 

Insert Structure 

Insert Structure is designed for typed-in entries. For example, to insert 2-bromobenzoic acid: 

1. Choose Convert Name to Structure from the Structure menu. 

The Insert Structure dialog box appears. 

2. Type 2-bromobenzoic acid. 

NOTE: You can also copy a name to the clipboard and type Crtl+V or Command+V to paste the name 

into the dialog box. 



3. Click OK. The molecular structure and name (if “Paste name below structure” is selected) appear in 

the drawing area. If you should happen to type the name incorrectly, Insert Structure will try to correct 

the error. 

Click OK to accept the suggested spelling, or click Cancel and start again to make a manual 

correction. 

Paste Special The Paste Special command allows you to paste a name, copied to the clipboard from 

another application, as a structure in ChemDraw. To paste a name from the clipboard: 1. Click in the 

document window. 

2-bromobenzoic acid 

130•Struct<=>Name CambridgeSoft Name=Struct 

Administrator 

2. Point to Paste Special on the Edit menu, and choose Name as Structure. The structure appears in 

your document. Converting Captions to Structures 

If a caption is already present in the drawing area you can convert it to a structure as follows: 1. Select 

the caption. 

Figure 7 - 6: Selecting a caption 

2. Choose Convert Name to Structure from the Structure menu. The molecular structure and name 

appear in the drawing area. Types of Structures Supported by Struct=Name Struct=Name can name 

compounds in the following classes of structures: 

RESULT: 

        We learned how to convert the name into structure of the chemical compounds using chem draw. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Experiment: 9 

MOLECULAR DOCKING STUDIES 

Aim. 

To learn how to perform molecular docking of the organic compounds using Chemdraw. 

Docking and Floating 

You can dock or float any standard toolbar. When you dock a toolbar, it becomes attached to 

the drawing window. Thefloating toolbars appear in front of the document window and you 

can move them around in the drawing window.Double-clicking the toolbar restores it to the 

last, or default, or docked position. 

To dock a toolbar, do one of the following: 

Click and drag the toolbar to any edge outside the drawing window. 

Right-click the toolbar and select Dock Toolbar.To float a toolbar, do one of the following: 

Double-click the docked toolbar.Click and drag the docked toolbar into the drawing window. 

Right-click the toolbar and select Float Toolbar. 

Docking and UndockingToolbars 

The standard toolbars, can be docked or undocked.Docked toolbars can attach to any edge of 

the  

ChemDraw window. Undocked toolbars can floatanywhere on your monitor screen. 

To dock a toolbar: 

• Drag the toolbar to the edge of the ChemDraw screen where you want it to dock. 

• Double-click the toolbar background. This will dock the toolbar in the default position. 

(Alltoolbars default to the top of the ChemDrawwindow, except for the Tools toolbar 

whichdefaults to the left side.) 

To undock a toolbar do one of the following: 

• Drag the toolbar into the position you want. 

• Double-click the toolbar. 

Result: 

We learnedabout the molecular docking of the organic compounds using Chemdraw. 
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